Essentials of design management with Rational Software Architect

Lab exercises (Self-paced training)
### Contents

**Overview**
- The Money That Matters Scenario ................................................................. 5
- Roles Played During the Labs ........................................................................ 7
- Set Up and Configure the Lab Environment .................................................. 9
- Icons .............................................................................................................. 11

**Initiate a Project Release** ............................................................................. 12

**Lab 1**  
Share Design Information With the Team ....................................................... 13
1. Share an Existing Rational Software Architect Project .............................. 13
   1.1 Create and Configure a Design Management Project Area .................. 13
   1.1.2 Create a Configuration Space for the DM-ISPT Project ................. 15
   1.1.3 Import Existing Assets Onto the Design Management Server ......... 16
   1.1.4 Manage the Project Area With the Design Management Server ... 17
1.2 Create a Lifecycle Project for Collaborative Design ............................... 18
   1.2.1 Deploy the Money That Matters Sample Project ......................... 19
   1.2.2 Configure the Money That Matters Sample ................................. 21
   1.2.3 Review the Money That Matters Sample Configuration ............... 22
   1.2.4 Prepare the Workspace for the Current Sprint ......................... 24
1.3 Summary ..................................................................................................... 26

**Plan the Sprint** ............................................................................................. 28

**Lab 2**  
Explore the Potential Impact of a New Requirement .................................... 29
2. Request Design Information As the Product Owner ................................. 29
   2.1 Provide Design Information As the Architect .................................. 31
   2.3 Summary ................................................................................................. 34

**Lab 3**  
Explore Design Options to Meet Business Needs ........................................ 35
3. Create a Design Document to Capture the Technical Vision .................... 35
   3.1 Brainstorm Design Ideas by Using Sketches ................................... 36
   3.2 Outline the Mechanisms to Support Dividend Allocation ................ 36
   3.2.1 Sketch the Service and Resources to Support Dividend Allocation 38
   3.3 Gather Technical Information in the Design Document .................... 40
   3.4 Summary ................................................................................................. 41

**Lab 4**  
Examine the Technical Solution to Evaluate the Development Effort .......... 42
4. Analyze the Impact of a Change on the Current Application .................... 42
   4.1 Find Reusable Assets ........................................................................... 44
   4.3 Summary ................................................................................................. 47

**Complete Stories During a Sprint** .............................................................. 48

**Lab 5**  
Refine the Design to Support the Implementation of User Stories .............. 49
5. Refine the Design by Using the Rational Software Architect Desktop Client ........................................................................................................ 49
   5.1 Connect the Desktop Application to the Design Management Server ... 49
   5.1.2 Create a New Service Model ......................................................... 53
5.2 Refine the Design by Using the Web Interface ....................................... 56
5.3 Summary ..................................................................................................... 58

**Lab 6**  
Create and Manage a Formal Review .......................................................... 59
6. Create a Design Review ............................................................................... 59
   6.1 Participate in a Design Review ............................................................ 61
   6.3 Follow the Review Progress ............................................................... 64
   6.4 Summary ................................................................................................. 66

**Lab 7**  
Work With Workspaces and Deliver Change Sets ....................................... 67
7. Compare Workspaces Content ................................................................... 67
   7.2 Deliver Change Sets That Were Created During the Sprint 2 Iteration .. 68
   7.3 Summary ................................................................................................. 70

**Stabilize the Sprint** .................................................................................... 71

**Lab 8**  
Customize Design Management Dashboards ................................................. 72
8. Work With Project Dashboards and Personal Dashboards ....................... 72
   8.1 Summary ................................................................................................. 76
Overview

IBM® Rational® Software Architect enables teams to share, collaborate, and manage design information across the application development lifecycle.

The Essentials of design management with Rational Software Architect self-paced training provides an introduction to design management. The training explains how to integrate design into the overall application and systems engineering lifecycles. You learn how teams can collaborate on designs across organizational boundaries to more efficiently manage a collaborative development lifecycle.

Important
This workbook is a complement to the Essentials of design management with Rational Software Architect self-paced training. Go to the self-paced training page and start from module 1.

This workbook provides instructions for hands-on exercises. You first read a training module in Essentials of design management with Rational Software Architect to understand the context and the technical concepts. Then, you follow the instructions to complete the corresponding lab.

The help topics in the information center provide links to additional resources. Explore the selection of help topics, tours, tutorials, samples, videos, and articles to learn more about the features that are described in each training module.


The Money that Matters scenario

All the exercises are based on an end-to-end development scenario. The Money that Matters lifecycle scenario uses a fictitious banking company called JKE and a realistic software development project whose goal is to deliver Release 1 of the JKE Banking application.

The Money that Matters scenario focuses on a single sprint by the team that is responsible for delivering an initiative called "Business Recovery Matters", as illustrated in the following figure.
All the action in the scenario occurs within one sprint for one team. For this self-paced training, the team is using the Design Management capabilities of IBM® Rational® Software Architect to manage design information. The scenario focuses on design practices, activities, and collaboration that occur in a single sprint.

The scenario can be applied to larger enterprise projects. The focus of the self-paced training is to learn about design management, but your team can also use these other lifecycle products:

- IBM Rational Team Concert to plan, track, collaborate, and deliver the release
- IBM Rational Requirements Composer to capture and manage requirements
- IBM Rational Quality Manager to plan, construct and execute tests

A complete lifecycle integration is illustrated in the following figure.
Roles played during the labs

Throughout the labs, you play different roles to experiment with collaborative design management capabilities. Architecture and design is not the responsibility of a single person: it is a team effort to develop and deliver a system. The objective of the labs is to demonstrate that the whole team collaborates on design activities.

The following table describes the different roles in the scenario and when they occur.

<table>
<thead>
<tr>
<th>Photo</th>
<th>Name</th>
<th>Role</th>
<th>Description</th>
<th>Lab</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bob</td>
<td>Product owner</td>
<td>Bob is the owner of the Business Recovery Matters solution. He is responsible for representing the stakeholders’ needs and for prioritizing the product backlog.</td>
<td>Lab 2: Explore the potential impact of a new requirement</td>
</tr>
<tr>
<td><img src="image1.jpg" alt="Bob" /></td>
<td>Al</td>
<td>Architect</td>
<td>AI is responsible for the architecture of the Business Recovery Matters solution. He explores design options to support the development of the stories that Bob provides.</td>
<td>Lab 1: Share design information with the team Lab 2: Explore the potential impact of a new requirement Lab 3: Explore design options to meet business needs Lab 5: Refine the design to support the implementation of user stories Lab 6: Create and manage a formal review Lab 7: Work with workspaces and deliver change sets Lab 8: Customize design management dashboards</td>
</tr>
<tr>
<td><img src="image2.jpg" alt="Al" /></td>
<td>Marco</td>
<td>Development lead and scrum master</td>
<td>Marco is a developer and team lead. He is also the scrum master responsible for coaching the project teams on agile practices.</td>
<td>Lab 4: Examine the technical solution to evaluate the development effort</td>
</tr>
</tbody>
</table>
Deb is a developer that practices test-driven development and continuous builds. She develops and writes unit tests for the stories that Bob provides.

At the beginning of the scenario, you set up the collaborative environment as a Design Management Server administrator.

As you play different roles, the self-paced training walks you through design activities conducted during a sprint, as illustrated in the following figure.
Set up and configure the lab environment

To complete the different labs, you need to access a Design Management Server. Install and configure Rational Software Architect Design Management Server if you can not reuse an existing server.

- Installing and configuring the Design Management Server

To complete the lab named Share design information with the team, you need to use the Rational Software Architect Import Engine. Install Rational Software Architect Import Engine if you can not reuse an existing import engine.

- Installing the Rational Software Architect Import Engine

To complete the lab named Refine the design to support implementation of user stories, you need to install Rational Software Architect V8.5 (the Eclipse application) and the design management extension.

- Installing and updating Rational Software Architect
- Installing the Rational Software Architect Design Management Client Extension

If you do not have a license for Rational Software Architect V8.5, you can download a trial edition.

- Installing a trial of Rational Software Architect, version 8.5

After Rational Software Architect and the design management client extension are installed, open IBM Installation Manager and click File > View Installed Packages. The installed packages are listed, as illustrated in the following figure.

For more information about Rational Software Architect Design Management Server or to download other collaborative lifecycle management (CLM) products, see the following resources:

- https://jazz.net/products/design-management/
- https://jazz.net/downloads/

After you install and configure the Design Management Server, create a sample user. Contact your Design Management Server administrator if you do not have the administration access.

- Managing users
Before you start the labs, ensure that your profile is associated with a **Rational Software Architect - Designer** license and that it has the **JazzProjectAdmins** permission, as illustrated in the following figure.

The JazzProjectAdmins permissions enable you to manipulate project areas, team areas, and process templates.
## Icons

This document uses the following symbols.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Purpose</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Important!" /></td>
<td>Important!</td>
<td>This symbol calls attention to a particular step or command. For example, it might alert you to type a command carefully because it is case sensitive.</td>
</tr>
<tr>
<td><img src="image" alt="Information" /></td>
<td>Information</td>
<td>This symbol indicates information that might not be necessary to complete a step, but is helpful or good to know.</td>
</tr>
<tr>
<td><img src="image" alt="Troubleshooting" /></td>
<td>Troubleshooting</td>
<td>This symbol indicates that you can fix a specific problem by completing the associated troubleshooting information.</td>
</tr>
<tr>
<td><img src="image" alt="CLM scenario" /></td>
<td>CLM scenario</td>
<td>This symbol indicates information that pertains to the collaborative lifecycle management (CLM) scenario.</td>
</tr>
</tbody>
</table>
Initiate a project release
Lab 1  Share design information with the team

The first part of the lab explains how to create a project area on the Design Management Server and import an existing IBM® Rational® Software Architect project.

The second part of the lab uses the Money that Matters sample to demonstrate key aspects of lifecycle project configuration.

In both cases, the Design Management Server is the central repository for collaborative design activities. Versions of design resources exist in a configuration space. Team members can access assets from the design Explorer. The project dashboard provides access to design information.

Time required: Approximately 90 minutes

1.1  Share an existing Rational Software Architect project

There are different Design Management usage models. This section covers a scenario where a team adopts the Design Manager Server for better collaboration, but uses existing design assets that were developed by using Rational Software Architect.

1.1.1  Create and configure a Design Management project area

Objectives of this section: A project area is a system representation of a software project. The area defines the project deliverables, team structure, process, and roles. To start collaborating with your team on the Design Management Server, you must define a project area.

___1. Open a browser and go to the Jazz Team Server administration page at https://host_name:9443/jts/admin.

___2. Log on with your user name and password.

___3. On the Jazz Team Server administration page, scroll down to the last section (Application Administration) and click Create Project Area under the Design Management section.

___4. For the project name, type DM-ISPT.

___5. In the Process section, select Basic.

___6. Add yourself as a member and an administrator to the new DM-ISPT project.
To create the project, click **Save**.

After the project is created, assign yourself a process role: in the **Member** section, hover the mouse pointer over the row where your name appears. Action icons are revealed, as illustrated in the following figure. Click the **Process Role** icon (first from the left) in the **Actions** column.

<table>
<thead>
<tr>
<th>Name</th>
<th>Process Roles</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>JL_Marechaux</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Add the **Editor**, **Architect**, **Publisher** and **Project Lead** roles and click **OK**, as illustrated in the following figure.

To confirm your changes, click **Save**.

On the **Home** menu, select the new **DM-ISPT** project. You are redirected to the DM-ISPT project dashboard, as illustrated in the following figure.
1.1.2 Create a configuration space for the DM-ISPT project

Objectives of this section: You created the project area to host your project. You need a configuration space to manage the versions of your design assets. With a configuration space, you can add, edit, and delete versions of resources in a workspace.

1. On the Administration menu, click Manage Project Properties, as illustrated in the following figure.

2. Under Versioning, open the Configure Space page.

3. Choose the Create new space for this project area option and name it DM-ISPT workspace.

4. To create the workspace, click Save. When you are redirected to the dashboard, note that the current configuration context in the upper-right corner is now DM-ISPT workspace, as illustrated in the following figure.
1.1.3 Import existing assets onto the Design Management Server

**Objectives of this section:** In a typical workflow, you do not start design collaboration with a blank project. In this section, you import an existing Rational Software Architect project that contains the architecture of the system that you have been building and maintaining for years. The import process populates the Design Management repository with your design assets.

__1. __Verify that the import engine is installed in your environment. If necessary, follow the instructions on the [Design Management Import Engine installation](#) page.

__2. __To set up the import engine, follow the instructions on the [Design Management Import Engine configuration](#) page. Verify that the import engine is configured and running.


__4. __Extract the file to a location that the import engine can access. For this exercise, assume that the import engine can access files on the C drive and extract the files to C:\dm-ispt\ispt-workspace.

__5. __From the Design Management dashboard, select **Import > Import Definition**.

__6. __Select the **Import an entire workspace** option.

__7. __Specify the name of your import engine (see step 2) and the location of the workspace (C:\dm-ispt\ispt-workspace).

__8. __Click **Test** near the import engine name to verify the connection to the import engine.

__9. __Click **Save** to save the import definition.

__10. __To start the import process, on the main menu, click **Import > Request Import**. Verify that the **Reimport and overwrite all resources** option is checked and click **Request Import**.

__11. __To follow the progress of the import process, click **Import > Import Status**.

__12. __After the import is processed, which can take several minutes, the **Progress** column in the **Import Status** page is set to **Completed**. On the **Designs** menu, click **Explorer**. Your design assets are available on the Design Management Server, as illustrated in the following figure.
1.1.4 Manage the project area with the Design Management Server

Objectives of this section: You imported existing design assets onto the Design Management Server. You can continue to update the design in Rational Software Architect and import the project each time that a new version is available. But, if you want to create design resources directly in the server repository, you must manage the project area on the server.

1. On the Administration menu, click Manage Project Properties.

2. Under Modeling, click Domains. Select the Actively managed with Design Manager check box and click Save. When you are prompted to confirm your change, click OK. A list of domains is displayed on the page. Some domains are selected by default to support the models that you imported.

3. To be able to create design documents and sketches on the server, select Documentation System Domain.

   Documentation System Domain
   If the Documentation System Domain is not associated with the project area, the Document and Sketches items are not available on the Designs menu under Create Design Resources.

4. Save your change. You are asked to specify a version for the new domain. Choose [0.1] and click OK.
5. Because your project is actively managed on the Design Management Server, you can start creating resources from the **Designs** menu, as illustrated in the following figure.

### Scenario simplification
To simplify the scenario, the steps stop here. In a real project, you would start collaborating on the design assets that are shared on the Design Management Server.

The next steps use the Money that Matters sample application instead of the one that you imported. The sample contains comprehensive predefined content such as design resources, users, roles, and links.

### 1.2 Create a lifecycle project for collaborative design
You use a lifecycle project to create and manage project areas from multiple applications, and to establish associations between those project areas. For example, you can use the application to create and manage a change and configuration management project area, a quality management project area, a requirements management project area, and an architecture management project area, and you can establish lifecycle traceability between each of those applications.

**Before you start**
You must be a Jazz administrator (**JazzAdmins**) to perform the tasks in this section. Contact an administrator to obtain the sufficient permissions.
1.2.1 Deploy the Money that Matters sample project

Objectives of this section: The Money that Matters sample is based on a realistic software development project whose goal is to deliver Release 1 of the JKE Banking application. The sample provides an internal perspective of the collaboration that occurs on a typical agile team. By creating the sample project on the server, you obtain a feature-rich environment that demonstrates multiple design management capabilities. The sample contains predefined resources such as users, roles, design models, and dashboards.

<table>
<thead>
<tr>
<th>Lifecycle projects</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the Design Management capabilities are installed on a shared Jazz Team Server with other applications, you can establish traceability between design management resources and the resources in requirements management (RM), change and configuration management (CCM), and quality management (QM) applications.</td>
</tr>
</tbody>
</table>

1. Open a browser and log on as a member of the JazzAdmins group to the Lifecycle Project Administration application on the Jazz Team Server: https://host_name:9443/admin/web

2. Click the Sample tab.

3. If an error message is displayed, as illustrated in the following figure, just click the Click here link and go to the next step.

Welcome to the Money that Matters sample

**The predefined template to create the sample with the combination of applications that are selected has not been imported. It is possible that predefined templates were imported using an earlier version of the Lifecycle Project Administration application. Click here to import all predefined templates.**

<table>
<thead>
<tr>
<th>Deploy predefined templates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lifecycle projects are created using templates. The first time you create a lifecycle project on a Design Management Server, you must deploy the predefined templates. Next time you create a lifecycle project, this step will not be necessary.</td>
</tr>
</tbody>
</table>
4. In the **Create sample project** section, ensure that only the /dm check box is selected, as illustrated in the following figure.

---
**The CCM component of the sample project**
The sample project contains a change and configuration management (CCM) component. If you select the /ccm check box, you require a Rational Team Concert license.

---
**Available applications in a CLM environment**
In a stand-alone Design Management installation, the available applications are /dm and /ccm. Requirements management (RM) and quality management (QM) options are only listed and available for selection if they are installed on the same server.
5. Click Create and confirm the sample creation. A new JKE Banking project and its related artifacts are created in each application that you selected.

6. After the project sample is created, click the Manage Project link.

### Locate the Application Administration page
Another way to access the project area page is to go to https://host_name:9443/admin/web and click the JKE Banking (Design Management) link.

## 1.2.2 Configure the Money that Matters sample

**Objectives of this section:** After the Money that Matters sample is created, you must assign licenses to users to enable capabilities. You want to enable design management capabilities for the user named Al.

1. In the JKE Banking (Design Management) project area, select the user Al.

2. When Al’s page is displayed, verify that JazzUsers is selected in the Repository Permissions section.

3. In the Client Access Licenses section, select Rational Software Architect – Designer and click Save.

4. Assign the following Client Access Licenses to the other team members:
   - Bob: Rational Software Architect – Contributor
   - Deb: Rational Software Architect – Contributor
   - Marco: Rational Software Architect – Contributor

### License for other team members
Licenses for Bob, Deb, and Marco are not required for this lab as they do not conduct any activity. Nevertheless, you must assign licenses to them to complete the other labs.

5. You are still logged in as an administrator. In the upper-right corner of the page, select the Log Out option under your profile as illustrated in the following figure, and then close the browser to avoid any caching problems.
1.2.3 Review the Money that Matters sample configuration

Objectives of this section: You created the Money that Matters sample project as an administrator. From now on, you play the role of Al the architect. You review the project properties to understand the artifacts that were created automatically with the sample project.

1. Open a new browser and go to https://host_name:9443/dm/web.

2. Log in using al as the user name and password (lowercase).

3. On the JKE Banking (Design Management) page, click the Explore dashboard link to open the JKE Banking (Design Management) project dashboard.

4. On the Administration menu in the upper-right corner, click Manage Project Properties.

5. Open the Project Linking page and review the link types that are defined automatically when the sample project is created.

   Design Management and OSLC links
   Design Management uses the Open Services for Lifecycle Collaboration (OSLC) specification for linked data.

6. Open the Domains page, and notice that the project area is actively managed in Design Management. Review the different domains that are associated with the project automatically when the sample is created. Domains enable modeling capabilities.
The Money that Matters sample uses several Rational Software Architect domains for deployment modeling, Business Process Modeling Notation (BPMN) modeling, sketching, and UML diagrams. The sample also uses the Documentation System Domain to create design documents and sketches from the Design Management web interface.

7. Open the Configure Space page. Notice that a configuration space named **JKE Banking (Design Management)** is created automatically to manage all resource version information.

8. On the Designs menu, click **Explorer**, as illustrated in the following figure.

9. Review the different design resources that are created automatically with the sample project, as illustrated in the following figure.
1.2.4  Prepare the workspace for the current sprint

Objective of this section: You created the Money that Matters sample project as an administrator. From now on, you play the role of Al the architect. You review the project properties to understand what was created automatically with the Money that Matters sample project.

1. Return to the main project dashboard. Note that the dashboard is always accessible on the Home menu by clicking JKE Banking (Design Management), as illustrated in the following figure.

![JKE Banking (Design Management)](image)

Lifecycle integration and dashboards
In a CLM environment, the Home menu provides access to the dashboards of the different CLM applications that are installed on the shared server (change management, requirements management, and quality management).

2. On the Current Configuration Context menu, click Create New Snapshot, as illustrated in the following figure.
3. Type Initial Snapshot and click Create. A Return to previous application link is displayed, which links to the JKE Banking dashboard. Click the link to return to the dashboard. Notice that the Current Configuration Context is now set to the initial snapshot that you just created.

**Snapshots**

A snapshot is a read-only list of resources and their versions that are part of a project at a specific point in time, for example, before and after a project milestone is reached. You must create a snapshot at the start of a project; you might create additional snapshots when project milestones are reached.

4. On the Current Configuration Context menu, click Create New Workspace, as illustrated in the following figure.

**Workspaces**

A workspace configuration, or workspace, is the mechanism by which you manage sets of versions for each resource.

5. In this lab, you assume that the team has completed the first iteration in an agile development sprint, and is now focusing on Sprint 2. Name the workspace Sprint 2, click Create, and return to the JKE Banking dashboard.

6. To quickly customize the dashboard to share information with your team, on the JKE Banking (Design Management) dashboard, in the upper-right corner, click Add Widget.

7. Select the General widget category and find the Headlines widget. Click Add Widget to add it to the dashboard.
8. Close the widget catalog using the red cross in the upper left corner, as illustrated in the following figure.

9. In the new Headlines widget, click **Edit Contents**. Customize the content with a message, such as: **Team, Sprint 2 has started. Don’t forget to use the Sprint 2 Workspace for your changes.** Then click **OK** to return to the dashboard.

10. To commit your changes, click **Save**. The dashboard and the information that it contains is accessible to all the project stakeholders, as illustrated in the following figure.

### 1.3 Summary

In this lab, you experimented with two ways of sharing design information on a Design Management Server.

First, you created and configured a Design Management project. Using the import engine, you imported existing Rational Software Architect design artifacts onto the Design Management Server to start collaborating on designs.
Second, you created a lifecycle project to host the design resources for your team. Using the Money that Matters sample, you quickly specified a project with predefined members, roles, design resources, and a configuration space. Then, you created a snapshot and a workspace to support parallel team development and version information. At the end, you used the project dashboard to communicate information to the team.
Plan the sprint
Lab 2  Explore the potential impact of a new requirement

In this lab, you first play the role of Bob the product owner. Bob needs information about the current design and he posts comments on the Design Management Server to request feedback.

Then, you play the role of Al the architect who is notified about a new security requirement. Al uses design management capabilities to explore the design resources. The team performs collaborative design activities using the Design Management Server.

**Contributor license for Bob**
Before you start, ensure that you assigned a Rational Software Architect – Contributor license to Bob, as specified in the Money that Matters sample configuration (see the lab named Share design information with the team).

Time required: Approximately 45 minutes

2.1 Request design information as the product owner

**Objectives of this section:** You play the role of Bob the product owner and you are preparing for the sprint planning meeting. You review the product backlog to evaluate whether your stakeholders submitted any new requests. While reviewing the backlog, you find a new compliance requirement.

- Requirement name: User Authentication Lockout
- Requirement short description: User login is limited to a certain number of tries before lockout.

As a product owner, you must validate with Al the Architect if the current architecture supports this security requirement.

**CLM scenario**
In a CLM environment, the requirements management application would capture the User Authentication Lockout requirement, and a task in the change management application would capture the work to complete.

**Money that Matters sample project**
In a CLM environment, the Money that Matters sample project provides a predefined requirement named “User Authentication Lockout”.

2. Log on by entering bob as the username and password (lowercase).
3. On the All Projects page, click the **Explore Dashboards** link to open the JKE Banking (Design Management) dashboard.
4. Review the content of the Headlines widget that states that all team members need to use the dedicated workspace during Sprint 2, as illustrated in the following figure.

5. On the Current Configuration Context menu, click Search for more, as illustrated in the following figure.

6. In the search field, enter Sprint. Sprint 2 is displayed in the matching items section. Select it and click OK. You are now using Sprint 2 as your current workspace.

7. Use the quick search feature to find a model element resource. In the Search Designs field in the upper-right corner, enter Login Unsuccessful and click the Search icon.

8. In the Search Results list, click the Login Unsuccessful sequence diagram.

9. Add a question about whether users are locked out after several failed login attempts:

   a. Click the New Comment icon and enter the following subject: Lockout Question.

   b. Enter the following comment: Will the user be locked out after a certain number of failed attempts?

   c. Use the circle shape from the drawing palette to circle the invalid login section of the diagram. The circle shape is available from the toolbar, as illustrated in the following figure.
d. You can add other visual markup from the palette, as illustrated in the following figure.

![Displaying the drawing palette]

Displaying the drawing palette
The drawing palette is only visible when the comment is in edit mode. If needed, select the comment and click the pencil icon to edit it. The drawing palette is displayed.

e. To save the comment and marked-up design, click OK.

10. Log out and close the browser.

CLM scenario
In a CLM environment, you can perform additional steps to link the design diagram to a requirement and to a task, which enables lifecycle traceability.

2.2 Provide design information as the architect

Objectives of this section: In-context collaboration is crucial to improve the quality of designs. Design Management Server features are particularly useful when all team members are not co-located. As a project stakeholder, you search and access shared design information on the Design Management Server. You post comments and visually mark up a design diagram.
As the architect, you are notified that someone needs your input on the current architecture. You use comments on the design to facilitate collaborative work and to keep track of the discussions among the team.

**CLM scenario and notifications**

There are many ways to be notified in a CLM environment. Instant messaging can be enabled to support chats. Users can subscribe to specific work items and receive email notifications when a change occurs. In work item comments, the @user feature can be used to send a specific email message to the target user. For example, a comment with the @al mention sends an email to Al.

2. Log on by entering al as the username and password (lowercase).
3. On the All Projects page, click the **Explore Dashboards** link to open the JKE Banking (Design Management) dashboard.
4. Verify that **Sprint 2** is the current context, as illustrated in the following figure. Change the context if necessary.

5. On the dashboard, review the content in the **Recent Comments** widget. The comment that Bob posted is listed with a link to the commented design resource, as illustrated in the following figure.

6. In the **Recent Comments** widget, click the **Login Unsuccessful** link to open the resource.
7. Review Bob’s question on the Login Unsuccessful sequence diagram. In the Comments view, click the comment to display the related drawing that was added to the diagram.
8. In the Comments view, click the **Reply to Comment** icon, as illustrated in the following figure. Then enter **Capability for user lockout is in place but the configuration parameter for number of tries needs to be changed.**
9. Click **OK**. Your answer to Bob’s comment is saved, as illustrated in the following figure.

---

11. Log out and close the browser.
2.3 Summary

In this lab, you used the search feature to find design information about logging in. As the product owner, you commented on a sequence diagram to ask for further information. To be specific with your comment, you used the drawing capabilities to mark up the portion of the diagram on which you need feedback.

Then, as an architect, you reviewed the comment and the related drawing to provide a response. In both cases, you used in-context collaboration features, such as comments, visual markup, and the project dashboard, to complete your work efficiently.
Lab 3   Explore design options to meet business needs

A new requirement was added to the product backlog: Allocate dividends to a cause. Before the team members commit to implementing the requirement during the sprint, they need to quickly explore a technical solution for the new requirement.

Iteration modeling is part of the iteration planning effort. In this lab, you create new design resources from a web browser to explore design options, verify the technical feasibility, and ensure alignment with requirements. The result of this design work is used for sprint planning to decide whether the requirement can be added to the current iteration.

Time required: Approximately 60 minutes

3.1 Create a design document to capture the technical vision

Objectives of this section: To gather design ideas and decisions from the team members, you want to create a design document on the server. The design document supports rich-text formatting and links to other resources.


2. Log on by entering al as the username and password (lowercase).

3. On the All Projects page, click the Explore Dashboards link to open the JKE Banking (Design Management) dashboard.

4. Verify that Sprint 2 is the current context. Change the context if necessary.

5. On the Designs menu, under Create Design Resource, click Document and add the following attributes:
   - Title: Design Document - Allocate Dividend Service
   - Folder: JKE Banking (use the Edit icon to edit the location folder)

   ![Add Folder](Image)

   - Click Save to create the design document on the server.
3.2 Brainstorm design ideas by using sketches

In this section, you create two design sketches during a quick brainstorming session. Because the sketches are on the Design Management Server, they are accessible to all the stakeholders even if the team is distributed and any stakeholder can contribute. During the session, the team decides that the best technical approach is to create a RESTful service to support dividend allocation.

The objective of the session is not to complete any design work, but for the team to agree on a technical approach for the new requirement. Quick team modeling helps you accurately plan the work for the iteration.

3.2.1 Outline the mechanisms to support dividend allocation

Objectives of this section: You want to ensure that everyone on the team understands the new requirement. While the team brainstorms on the different components involved, you create a sketch to capture the different ideas, as illustrated in the following figure.

![Diagram of dividend allocation process]


2. Enter Allocate Dividends Overview as the title, and specify JKE Banking as the existing folder, as illustrated in the following figure.

3. Click Save to create the sketch. After the sketch is created, new tabs are displayed. Open the Sketcher Diagram tab.
4. Click the blank drawing surface to display the drawing palette, and then add the following elements:

   a. Three actors (stick)
   b. Three ovals (thought)
   c. One rectangle (thought)

5. Rename the rectangle JKE Server.

6. Rename the actors (stick) Donor, Recipient, and JKE Banking.

7. Rename the ovals Allocate dividends, Transfer funds, and Confirm funds transfer.

   Changing sketch element names
   To change the name of a sketch element, double-click the displayed text to switch to the edit mode. Then, enter the new name.

8. Create connections between these sketch elements:

   Creating sketch connections
   To create a connection, hover your mouse pointer over the source element: yellow arrows are displayed. Drag one arrow onto the target element: the connection is created.

   a. From Donor to Allocate dividends
   b. From Allocate dividends to JKE Banking
   c. From JKE Banking to these elements:
      i. JKE Server
      ii. Transfer funds
      iii. Confirm funds transfer
   d. From Transfer funds to Recipient
   e. From Confirm funds transfer to Donor

   After you draw the connections, your sketch should look similar to the following figure:
While you are updating the diagram, the server resource is locked. A message icon on the page indicates that nobody else can modify the diagram until you save it.

9. Click Save. The diagram is now unlocked and others can modify it.

3.2.2 Sketch the service and resources to support dividend allocation

Objectives of this section: Team members want to decide whether or not the new requirement can be contained in the Sprint 2 iteration. While the team brainstorms on the REST resources that are required, you create a sketch to capture the different ideas, as illustrated in the following figure.
1. On the **Designs** menu, under **Create Design Resource**, click **Sketch**.

2. Enter **Allocate Dividends REST Resources** as the title, specify **JKE Banking** as the existing folder, and click **Save**.

3. After the sketch is saved, open the **Sketcher Diagram** tab.

4. Click the drawing surface to display the sketching palette. Add a cloud to the drawing surface and name it **JKE Service**.

5. Add four rectangles and name them **User**, **Account**, **Organization**, and **Transaction**.

6. Add three connections to indicate that **JKE Service relates to User, Organization, and Transaction**.

7. Add a fourth connection to indicate a link from **User** to **Account**.

8. Save the sketch, which should look like the following figure.
3.3  Gather technical information in the design document

Objectives of this section: You update the design document to capture the results of the brainstorming session in a shared, centralized, and easy-to-access design resource.

1. Click **Designs > Explorer** and open the **Design Document – Allocate Dividend Service** resource.

2. On the **Properties** tab, place the cursor in the body of the rich-text document.

3. Add a brief description of what the team decided during the brainstorming session:
   - We will leverage a RESTful architecture that we have already implemented for another service. The Allocate Dividend Service must use resources such as User, Account, Organization, and Transaction.

4. On the toolbar, click the **Insert diagram** icon, which has a green arrow, as illustrated in the following figure.

5. In the **DM Item Selection** window, enter **Allocate** as the keyword and click the **Search** icon. Then, select the **Allocate Dividends Overview** sketch and click **OK**.

6. Repeat the same process to add the **Allocate Dividends REST Resources** sketch.

7. Save the design document. The sketches are added to the rich-text design document.

---

Diagrams with design documents

When a diagram is inserted into a design document, a pointer to the original diagram is created (the diagram is not duplicated).

You can navigate to the diagram resource by right-clicking the diagram image and clicking **Open Resource**.

---

Design change sets

Change sets are created automatically when design resources are saved. Change sets and versioning are out of scope for this lab.

---

8. Log out and close the browser.
3.4 Summary

In this lab, you created a design document on the Design Management Server. During a brainstorming session, the team created sketches to capture their thoughts. Team members developed a common vision of the technical solution to address the new requirement. Because the envisioned solution reuses existing design assets, the team is confident about the technical feasibility of the new requirement.
Lab 4  Examine the technical solution to evaluate the development effort

To decide if the new requirement can be contained within the Sprint 2 iteration, the team must evaluate the development effort. In this lab, you play the role of Marco, the development lead. Marco works with Al the architect and Deb the developer. To implement the Allocate Dividends requirement, Marco wants to understand what needs to be developed and what can be reused from existing assets.

The design document that Al created contains sufficient information to understand the technical approach to implement the new requirement (see the lab named Explore design options to meet business needs). This document is the starting point for Marco to evaluate the development effort.

Time required: Approximately 45 minutes

4.1 Analyze the impact of a change on the current application

Objectives of this section: In the design document for the new requirement, Al the architect mentioned that the JKE Server component must be modified. In this section, you conduct an impact analysis to understand how a change to the JKE Server can affect the whole solution.


2. Log on by entering marco as the username and password (lowercase).

3. On the All Projects page, click the Explore Dashboards link to open the JKE Banking (Design Management) dashboard.

4. Verify that Sprint 2 is the current context. Change the context if necessary.

5. On the Analysis menu, under the Create section, click Impact Analysis Diagram.

6. In the Target Element field, enter JKE Server and click the Search icon.

7. A list of design resources named JKE Server is displayed. Select the one whose type is UML-Component, as illustrated in the following figure, and click OK.
8. For the name of the impact analysis, enter Impact Analysis on JKE Server.

9. Click Save. The impact analysis starts with the default parameters and the impact analysis diagram is displayed.

10. You are specifically interested in the resources that are affected by a change to the JKE Server component. In the Impact Analysis Configuration field, choose the Upstream option and click Run. The impact analysis diagram is refreshed. Now it focuses on design resources that might be affected if you change the JKE Server component, as is illustrated in the following figure.
11. Click **Save** to save your changes.

12. Select a diagram element to show and click the **Preview** button. After the summary information is displayed, click the element name to drill down and access the design resource. If the team identifies affected resources, he estimated development effort increases.

**CLM scenario**
In a CLM environment, the impact analysis can contain both Design Management resources and CLM resources. For example, the analysis can help identify how a design change affects a requirement or a test case.

### 4.2 Find reusable assets

**Objectives of this section:** Now that you understand how the current application is affected if you modify the JKE Server component, you want to determine whether existing assets can be reused to implement the new requirement. All the architect has mentioned that existing services and web resources can be used. In this section, you use the query editor to find design resources with the “HTTP REST” or the “resource” keyword attribute.
1. On the **Designs** menu, under **Create**, click **Query**.

2. For the query name, enter **Existing Service Elements**.

3. In the description, enter **Lists all the design resources related to REST services and web resources**.

4. In the first query condition pane, replace **All must match** with **Any can match**, which changes the AND condition to an OR condition.

5. Click **Add Condition**, select **Property Value** (expand **Ontology Specific** in order to see this entry), and click **Add Attribute Condition**, as illustrated in the following figure.

6. In the Property Value pane, type **keyword** to filter the value choices and select **Keyword (UMLExtension)**. Then, in the **String** field, enter **resource**, as illustrated in the following figure.
7. Click Save.

8. Repeat the previous steps to add another condition to the query. This time you want to find the design resource with the HTTP REST keyword, as illustrated in the following figure.

9. Click Save, and then click the Run to run the query. The query lists design elements that have a resource stereotype or an HTTP REST stereotype applied, as illustrated in the following figure.

10. Hover your mouse pointer over the resource name to preview the resource or click it to open it. If the team decides that some assets can be reused, the estimated development effort decreases.
11. Log out and close the browser.

4.3 Summary

In this lab, you used the impact analysis capability to assess the impact of a change on the existing application. Then, you used the graphical query editor to find reusable design elements to address the new requirement. In both cases, your team assesses the development effort for the new requirement.
Complete stories during a sprint
Lab 5  Refine the design to support the implementation of user stories

During a sprint, teams refine the design to better support development activities. In this lab, you play the role of Al the architect. You create new design elements both from the Rational Software Architect desktop client and from a web browser. The design information that you add to the Design Management Server helps the team implement the new user stories during the current iteration.

Time required: Approximately 60 minutes

5.1 Refine the design by using the Rational Software Architect desktop client

In this section, you use the Rational Software Architect Design Management Extension to modify the models that are stored on the Design Management Server.

5.1.1 Connect the desktop application to the Design Management Server

Objectives of this section: To access models on the Design Management Server, you must define a server configuration from your local environment. After you connect to the server, you can access project content and browse the design resources.

1. Make sure that the Design Management extension for Rational Software Architect is installed (see the Overview section of this document for installation information).

2. Open Rational Software Architect V8.5 and specify a new target workspace (DM-ISPT), as illustrated in the following figure.

3. Verify that you are in the Modeling perspective. Otherwise, click Window > Open perspective to switch to the Modeling perspective.
4. In the Design Explorer view, click **Create a new connection**. Specify the address of your server (follow the https://{URI}:{port}/dm format) and enter al as the user and password (lowercase), as illustrated in the following figure.

5. Click **Finish** to create the connection.

6. In the Connect to Server Projects dialog box, select **JKE Banking (Design Management)** and click **Next**.

7. In the Select Workspace or Snapshot dialog box, click the project name in the left pane to retrieve the workspaces. Then select **Sprint 2** in the right pane, as illustrated in the following figure, and click **Finish**.
8. Review the project content. The Design Explorer displays the resources from the Design Management Server, as illustrated in the following figure.
9. On the menu, click **Window > Preferences**. Select **Design Repository** in the left pane and clear the **Share with others on save** check box, as illustrated in the following figure.
The **Share with others on save** check box automatically delivers the local changes to the server each time an element is saved locally. When the check box is cleared, you can decide when change sets are delivered to the server.

10. Click **OK** to save your changes.

**5.1.2 Create a new service model**

**Objectives of this section:** You have access to the design management resources from your desktop. As Al the architect, you want to create a service model to facilitate and accelerate the development of the
new Allocate Dividends service. You have also identified that a new REST resource is needed to implement the service. The account profile for a user is required to complete funds transfer.

**Design management views**
Rational Software Architect views to access design management resources are located in the Window > Show View > Others > Modeling section.

1. Open the Design Explorer view.
2. Expand JKE Banking (Design Management) > JKE Banking > JKE Design > Server.
3. To create a class that represents the account profile, right-click Resources and click Add UML > Class. The project name is highlighted.
4. Save the project to refresh the tree view and reveal the new class.
5. Select the class and open its Properties view. On the General tab, enter Profile as the name. Then, select the Stereotype tab and enter resource in the keyword field.
6. Save your changes.
7. Right-click JKE Banking (Design Management) > JKE Banking > JKE Design > Server and click Add UML > Package. The project name is highlighted.
8. Click Save (or press Ctrl+S) to create the new package. The Design Explorer view is refreshed and the new package is displayed. The package contains a default Main diagram.
9. Select the new package and, in the Properties view, change its name to Service Design.
10. Select the Main diagram under the Service Design package and change its name to Allocate Dividend Service Diagram.

**Service design content**
To simplify the lab, Al’s steps to create the service design stop here. In a more complete scenario, Al would add classes to the diagram to illustrate the design of the Allocate Dividends REST service.

11. Save your changes. The resources that you created are illustrated in the following figure.
Open the Design Changes view (Window > Show View > Others) to display all the available views.

A change set is created to capture all your changes (triangle icon). To enter a new comment, right-click the change set and click Rename.

Type Refine service design and click OK.

CLM scenario
In a CLM environment, you can associate work items with change sets. For example, you can associate a design change set with a Rational Team Concert task and then mark the task as complete.

All the changes occur in a private environment and are not yet visible to other users on the Design Management Server. To deliver your changes to the server, right-click the change set and click Share with Others, as illustrated in the following figure.

When the change set is delivered to the Design Management Server, resources are unlocked, and others can see your changes on the server.

5.2 Refine the design by using the web interface

Objectives of this section: If you can update designs from Rational Software Architect, you can also refine design information by using a web browser. In this section, you add links between design elements to enable traceability and impact analysis.


2. Log on by entering al as the username and password (lowercase).

3. On the All Projects page, click the Explore Dashboards link to open the JKE Banking (Design Management) dashboard.

4. Verify that Sprint 2 is the current context. Change the context if necessary.

5. On the Designs menu, click Explorer and verify that the elements created with Rational Software Architect in the previous section are listed, as illustrated in the following figure.

6. Click the Allocate Dividend Service Diagram to open it.

7. Click the Links tab and add a Refines link.

8. In the Add Link – Refines dialog box, complete these steps:
   a. Select JKE Banking (Design Management) for the project.
   b. Make sure that the Choose Existing option is selected.
   c. Click Browse and type Allocate dividend. Select the BPMN2 diagram named Allocate Dividends to Cause (Look for DM Diagram - Bpmn2 Diagram RMPDiagram in the Type column) and click OK.
_d._ Optionally, you can add a description for the link, as illustrated in the following figure. Then, to create the link, click **OK**.

---

__9.__ Add another **Refines** link to the **Allocate Dividends REST Resources** sketch. You have created links as illustrated in the following figure.

---

__10.__ On the **Home** menu, click **JKE Banking (Design Management)** to open the dashboard. The **Recent Links** widget now contains the links that you created, as illustrated in the following figure.
CLM scenario
In a CLM environment, you can link design resources to other lifecycle resources such as requirements, tasks, or tests.

11. Log out and close the browser.

5.3 Summary

In this lab, you used Rational Software Architect to access design information on a remote Design Management Server. You refined the models that are stored on the server by adding a new class and a new diagram. Then, you shared your changes to make them visible on the Design Management Server.

You also added links between design resources. Links are useful for traceability and impact analysis. You can also use links to navigate through design elements and understand how resources relate to each other.
Lab 6  Create and manage a formal review

A review is an assembled set of artifacts for specific team members to examine. In this lab, the team collaborates to verify that the design is consistent with the requirements and that the design information is complete and accurate.

First, you start in the role of Al the architect. You identify the design resources to review and the stakeholders to involve in the review activities.

Then, as Deb the developer, you complete the activities that are documented in the review on the Design Management Server.

Time required: Approximately 45 minutes

6.1 Create a design review

Objectives of this section: In this section, you play the role of Al the architect to initiate a design review. First, you create a review for a design snapshot to ensure that design resources are not updated while they are reviewed. Then, you specify the design resources to include in the review and you identify the participants.

__1.  Open a new web browser session and go to https://host_name:9443/dm/web.

__2.  Log on by entering al as the username and password (lowercase).

__3.  On the All Projects page, click the Explore Dashboards link to open the JKE Banking (Design Management) dashboard.

__4.  Verify that Sprint 2 is the current context. Change the context if necessary.

__5.  On the Current Configuration Context menu, click Create New Snapshot as illustrated in the following figure.

![Create New Snapshot](image)
6. Type **Sprint 2 – Design snapshot** as the snapshot name and click **Create**. A Return to previous application link is displayed, which links to the JKE Banking dashboard. Click the link to return to the dashboard.

7. On the **Reviews** menu, under the **Create** section, click **Review**.

8. On the review creation page, name the review **Allocate dividends design review** and ensure that the configuration attribute is set to **Sprint 2 – Design snapshot**. Change the attribute if necessary.

9. In the **Resources** section on the **Overview** tab, click the **Add** link.

10. In the search dialog box, type **Document**, click the search icon, select the **Design Document – Allocate Dividend Service** resource, and click **OK**. The resource is added to the review.

11. Click the **Add** link again to add another resource to the review.

12. In the search dialog box, type **Service diagram**, click the search icon, select the **Allocate Dividend Service Diagram** resource, and click **OK**.

 Missing resources
 If you have not completed the previous labs, the design resources to add to the review do not exist. You can add other resources from the JKE Banking model and work with these resources throughout the exercise.

13. In the **Participants** section of the **Overview** tab, click the **Add** link.

   a. In the search dialog box, type **Deb**, select **Deb** from the matching users, select the **Reviewer** role, and click **Add**.

   b. In the search dialog box, type **Marco**, select **Marco** from the matching users, select the **Reviewer** role, and click **Add**.

   c. In the search dialog box, type **Bob**, select **Bob** from the matching users, select the **Subscriber** role, and click **Add and Close**.

 Reviewers and subscribers
 Reviewers have review tasks assigned to them. Subscribers do not have specific tasks, but they can access the review and follow its progress.

14. In the main review section, specify a due date and optionally add instructions, such as the following text: Please review the listed resources. The design document includes two diagrams to review as well. The Service diagram links to other design resources to examine.
__15.  Click **Save**. The review is created as illustrated in the following figure.

![Review Creation](image)

**CLM scenario**

In a CLM environment, you can create a link between a design review and a Rational Team Concert task. Rational Team Concert provides review and approval mechanisms to support lifecycle reviews (requirement, test, and design).

__16.  Click **Start Review**. The status is now **In Progress**. Participants can start reviewing the design resources.

__17.  On the **Home** menu, click **JKE Banking (Design Management)** to open the dashboard. The **Reviews** widget now contains the review that you created, as illustrated in the following figure.

![Review Dashboard](image)

__18.  Log out and close the browser.

### 6.2 Participate in a design review

**Objectives of this section**: In this section, you play the role of Deb the developer. Al assigned you to a design review and you use the Design Management Server capabilities to complete your review work before the due date.

__1.  Open a new web browser session and go to **https://host_name:9443/dm/web**.

__2.  Log on by entering **deb** as the username and password (lowercase).

__3.  On the All Projects page, click the **Explore Dashboards** link to open the JKE Banking (Design Management) dashboard.

__4.  Verify that **Sprint 2** is the current context. Change the context if necessary.
5. On the dashboard, the review widget indicates that a review is started. The icon on the right specifies that you are a reviewer. Hover your mouse pointer over the review link to display summary information.

6. Click the review link to open the review. A message indicates that you need to change the configuration context, as illustrated in the following figure.

7. Click the configuration or changeset link. The context is automatically set to the correct configuration, Sprint 2 - Design snapshot.

Review and configuration context
When you create a review, you must specify the configuration context. To support parallel development, design resources have different versions in different workspaces. For a review, you must identify the set of design resources and their version.

8. Click the Overview tab to access the review instructions and due date.

9. Click the My Work tab to review the items that are assigned to you, as illustrated in the following figure.

10. Click the design document link to open it. Review its content, including the embedded sketches.

11. You notice that the account profile REST resource is not mentioned in the document and in the sketch. Click the New comment icon and type the following information:

   a. Subject: REST resources
__b. Comment: We talked about a new resource for the account profile. It should be mentioned in the document.

__12. Click OK to save the comment.

__13. On the Reviews menu, under Browse, click Reviews. Then, click the Allocate dividend design review to open it.

__14. On the My Work tab, hover your mouse pointer over the design document row. An icon to change the status is displayed, as illustrated in the following figure.

![186: Allocate dividends design review](image)

__15. Click the change status icon, select Reviewed – See comments from the list, and click OK.

__16. The progress of your review is automatically updated, as illustrated in the following figure.

![My Work tab](image)

__17. Click Save to save your progress.

__18. Click the Allocate Dividend Service Diagram link to open and review the resource.

__19. Open the Links tab to access related resources.

---

**CLM scenario**

In a CLM environment, design resources can link to other lifecycle resources such as requirements. You can use these links to verify that the design aligns with business needs.

__20. Return to the review by using the Review menu.
21. On the My Work tab, hover your mouse pointer over the service diagram row. Click the change status icon, select Reviewed – no comments from the list, and click OK. Notice that the status is listed as Done because you reviewed all the resources.

22. Click Save to save your progress.

23. In the right pane, click Review Comment; then click the New Comment icon to add the following comment:

   a. Subject: Approved

   b. Comment: Allocate Dividend design sounds good to me and I have enough information to develop the new service.

24. Click OK to save the review comment. Comments are captured in the review, as illustrated in the following figure.

25. Log out and close the browser.

6.3 Follow the review progress

Objectives of this section: In this section, you play the role of Al the architect to follow the progress of the review. When the reviewers complete their activities, you finalize the review.


2. Log on by entering al as the username and password (lowercase).

3. On the All Projects page, click the Explore Dashboards link to open the JKE Banking (Design Management) dashboard.

4. Verify that Sprint 2 - Design snapshot is the current context. Change the context if necessary.

5. On the dashboard, verify that the Recent Comments widget contains the comments that Deb submitted, as illustrated in the following figure.
6. In the **Recent Comments** widget, click the **Allocate dividends design** review link. The review opens.

7. The **Overview** tab shows real-time information about the review. The review is 50% completed because one of the two reviewers completed the work. The **Participants** and **Resources** sections show the review results and progress for each participant.

8. Click the different tabs to review the information that they contain. Notice that the comments added by the participants during the review are accessible in the right pane.

---

**Scenario simplification**

To simplify the scenario, the steps to review the design resources stop here. In a real project, you would incorporate suggested changes to the design resources, and you would play the role of Marco, the other reviewer, to complete the review activities.

The next steps focus on the review status to demonstrate how to finalize a review.

---

9. On the **Overview** tab, click **Finalize Review**. A dialog box opens for you to enter a review summary. Type in the following text: All reviewers have approved the Allocate dividends design. Deb the developer states she has enough design information to implement the service.

10. Click **Finalize**.

11. On the **Reviews** menu, under **Browse**, click **Reviews**. In the upper-right corner, click the filter icon.

12. In the Filter Reviews dialog box, under the **Review status** section, select **Finalized** and click **OK**. The Allocate dividends design review is displayed, as illustrated in the following figure.
13. Log out and close the browser.

6.4 Summary

In this lab, you created a review based on a design snapshot. You identified a set of design resources to review and the different team members involved in the review. Then you played the role of a reviewer to submit feedback on the design. Finally, as the review owner, you tracked progress, you examined comments and you finalized the review.

As the reviewers approved the design, your team is ready to move to the next step and implement the new service.
Lab 7  Work with workspaces and deliver change sets

In this lab, you work with multiple workspaces to experiment parallel design management. First, you examine the differences between two workspaces. Then, you access the change sets in the Sprint 2 workspace and you deliver the changes to the parent workspace

**Time required:** Approximately 30 minutes

---

### Changes from previous labs

If you have not completed the previous labs, you cannot follow the next steps. You need different workspaces and change sets to complete this lab. To simulate the result of the previous labs, you can add a design resource as explained in the next steps to create a new change set. The new change set will be sufficient to complete this lab.

---

### 7.1 Compare workspaces content

**Objectives of this section:** In this section, you compare the content of two different workspaces. Changes made in a child workspace are not visible in the parent workspace until they are delivered.

2. Log on by entering `al` as the username and password (lowercase).
3. On the All Projects page, click the **Explore Dashboards** link to open the JKE Banking (Design Management) dashboard.
4. On the **Designs** menu, under **Browse**, click **Explorer**. The page displays the design resources for the Sprint 2 context.
5. Expand the design nodes to verify that the resources that were created during previous labs are listed.

---

### Missing design resources

If you did not complete the previous labs, you can create a design resource now. Ensure that the context is set to Sprint 2 when you create the resource. The new resource is displayed in the Explorer view and you can continue with the next steps.
6. In the **Current Configuration Context** menu, select **JKE Banking (Design Management)** from the list. The **Explorer** page refreshes. Notice that the design resources that were created in the Sprint 2 workspace are not listed.

---

**Workspaces and parallel development**

Workspaces support parallel development. Changes made in a workspace are not visible in other workspaces until they are delivered.

---

7.2 **Deliver change sets that were created during the Sprint 2 iteration**

**Objectives of this section:** In this section, you deliver the changes made in Sprint 2 workspace to the parent workspace. After they are delivered, the changes are visible in the parent workspace.

1. On the **Home** menu, click **JKE Design (Design Management)** to open the project dashboard.

2. On the **Current Configuration Context** menu, click **Explore Configurations**, as illustrated in the following figure.

---

3. The Configurations page opens. Expand **JKE Banking (Design Management)** to reveal the configuration items that were created during the previous labs, as illustrated in the following figure.
4. Click Sprint 2 to open it, and then click the Change Sets link. The page displays all the change sets that were created during the previous labs, as illustrated in the following figure.

5. In the upper-right of the page, click the Deliver Outgoing Changes icon, as illustrated in the following figure.

6. On the Deliver Outgoing Changes page, examine the different changes. The left pane lists all the changes in the Sprint 2 workspace. The right pane lists the results of the deliver action.

7. Click the Commit merged result icon to deliver your changes, as illustrated in the following figure.

8. A confirmation message is displayed, as illustrated in the following figure. In the upper-left corner, click the Design Management link.

9. In the upper-left corner, click the Design Management link. Ensure that JKE Banking (Design Management) is the current configuration context, and then open the Design Explorer view. Notice that the design resources that were created in the Sprint 2 workspace are now visible from the parent workspace, JKE Banking (Design Management).

10. Log out and close the browser.
7.3 Summary

In this lab, you used the Design Management Server to examine the content of two different workspaces. You delivered change sets from one design branch (sprint 2 workspace) to the main workspace (JKE Banking). To support parallel development, workspaces are isolated from each other until you deliver changes.
Stabilize the sprint
Lab 8  Customize design management dashboards

Dashboards display various types of data from different sources on a single page, and they are useful for tracking status, progress, and activity at a glance. You can customize dashboards to track any data, and they provide links to more detailed information.

In the previous labs, you used dashboards to create or update design information to support the development of a new feature. In this lab, you use the project dashboard to expose design information to the team.

*Time required: Approximately 35 minutes*

8.1 Work with project dashboards and personal dashboards

**Objectives of this section:** In this section, you play the role of Al the architect. You modify a widget on the project dashboard to communicate information about the design review to the whole team. Then, you configure a query widget to display a list of reusable design assets. Finally, you access and customize your personal dashboard.

1. Open a new web browser session and go to https://host_name:9443/dm/web.
2. Log on by entering al as the username and password (lowercase).
3. On the All Projects page, click the Explore Dashboards link to open the JKE Banking (Design Management) dashboard.
7. Verify that Sprint 2 is the current context. Change the context if necessary.
8. On the JKE Banking (Design Management) dashboard, click the Reviews widget header and drag the widget to a different location.
9. By default, dashboard changes are only saved after you click Save in the upper-right corner of the screen. To automatically save you changes, select the Auto-save check box. The Save button disappears, as illustrated in the following figure.

   ![Auto-save check box](image)

10. On the Reviews menu, click Appearance as illustrated in the following figure.
11. Optionally, you can modify the appearance of the widget and click **OK**.

12. On the Reviews menu, click **Settings**, and set the **Reviews Filtering** field to **Past Month**, as illustrated in the following figure.

13. Click **OK** to commit your changes.

14. Next to the **General** tab, click the **Add New Tab** icon (+), click the tab name to edit it, and type **Design Elements**.

15. The new tab is empty. Click the **Add Widget** link to open the list of available widgets.

16. Notice that the **Search Catalog** attribute is set to **Design Management**.

---

**CLM scenario**

In a CLM environment, you have access to other widget catalogs, such as requirements management, change management, and quality management.
__17.__ Under **Select Category**, click **Design** to display the design widgets.

__18.__ Locate the widget named **Query** and click **Add Widget**.

__19.__ Close the widget catalog.

__20.__ In the query widget that you added, click the **Edit Settings** link and use the **Select** buttons to change the query attributes:

__a. Project: JKE Banking (Design Management)___

__b. Context: JKE Banking (Design Management)___

__c. Query: Class Type Listing___

__21. To confirm your changes, click **OK**. The widget now lists the classes from the project repository, as illustrated in the following figure.

__22. If you completed the previous lab named **Examine the technical solution to evaluate the development effort**, you can reuse the custom query that you created.

__a. Add another query widget to the dashboard.

__b. Specify **Existing Service Elements** as the query attribute, as illustrated in the following figure.
c. Click **OK** to display the query result, as illustrated in the following figure.

---

**23.** On the **Home** menu, click **Al's Dashboard**, as illustrated in the following figure.

---

**24.** You can customize your personal dashboard and even create multiple personal dashboards.

---

**25.** Note that in a CLM environment, a dashboard can contain information from different lifecycle applications. As an example, you can display information on project progress, design links to requirements, and traceability between requirements and test cases, as illustrated in the following figure.
26. Log out and close the browser.

8.2 Summary

In this lab, you customized the project dashboard. First, you modified a widget filter to expose review information to the whole team. Then, you created a project dashboard tab and you used the query widget to display the results of a predefined query (Class Type Listing) and a custom query (Existing Service Elements). Finally, you accessed and customized your personal dashboard.
Appendix A. Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction and intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental. All references to fictitious companies or individuals are used for illustration purposes only.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs.
Appendix B. Trademarks and copyrights

The following terms are trademarks of International Business Machines Corporation in the United States, other countries, or both:

<table>
<thead>
<tr>
<th>IBM</th>
<th>AIX</th>
<th>CICS</th>
<th>ClearCase</th>
<th>ClearQuest</th>
<th>Cloudscape</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cube Views</td>
<td>DB2</td>
<td>developerWorks</td>
<td>DRDA</td>
<td>IMS</td>
<td>IMS/ESA</td>
</tr>
<tr>
<td>Informix</td>
<td>Lotus</td>
<td>Lotus Workflow</td>
<td>MQSeries</td>
<td>OmniFind</td>
<td></td>
</tr>
<tr>
<td>Rational</td>
<td>Redbooks</td>
<td>Red Brick</td>
<td>RequisitePro</td>
<td>System i</td>
<td></td>
</tr>
<tr>
<td>System z</td>
<td>Tivoli</td>
<td>WebSphere</td>
<td>Workplace</td>
<td>System p</td>
<td></td>
</tr>
</tbody>
</table>

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and Telecommunications Agency which is now part of the Office of Government Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of The Minister for the Cabinet Office, and is registered in the U.S. Patent and Trademark Office.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium, and the Ultrium logo are trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.